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GPSeismic®
 

 

 
Document contents - This document contains a brief overview and tutorial for use of GPSeismic® software. Because of 

its importance, considerable time is spent on Geodesy. Consult individual manuals for detailed use of the QuikLoad, 

QuikView , GPSQL, QuikMap and QuikCon applications.  
 

When you see this image, read the corresponding section very carefully. 
 

 
Contact information - Dynamic Survey Solutions, Inc. (DSS Inc.) is a consulting and software development firm 

specializing in GPS and conventional surveying and is the developer of the GPSeismic®. 

Cliff Harris is the president and owner of DSS Inc.. He is in charge of technical direction and actively serves in the 
capacity of lead programmer. He is the author of QuikLoad, QuikView, QuikMap, and QuikEdit. Cliff graduated from the 

Colorado School Of Mines with a B.S. in Geophysics and worked for Shell Offshore and Shell Research for 12 years before 
forming DSS Inc. in 1993. 

e-mail cliff@gpseismic.com Telephone 1-802-872-7770 

Rudy Lambert has been both a programmer and trainer for DSS Inc. since 1994. He is the author of GPSQL, QuikCon, 
GPArc, GPNav, GPLocator, Project Manager and NGSearch.  Before joining DSS, he was employed by Offshore Navigation 

Inc. and served as Vice President of Applied Technology. He has a BS in Earth Science and a Masters in Science Teaching 
in Mathematics and Physics from the University Of New Orleans.  

 

e-mail rudy@gpseismic.com Telephone 1-828-263-0356 
 

Web site - http://www.gpseismic.com/ 
 

 
 
Software Overview 

 

A First Look  - If you are reading this, you probably are new to 
GPSeismic®, a suite of applications that represents several hundred 

megabytes of installed software. The normal question is “Where do I 
start?” and the standard answer is “It depends on what you want to do.”  

With GPSeismic®, you can perform actions as diverse as vehicle tracking 
or inertial navigation system processing. GPSeismic® currently consists of 

eleven applications. 

 
It is instructive to note that GPSeismic® started as two applications, QuikLoad and QuikView, in support of the Trimble 

real-time GPS stakeout system. QuikLoad imported or generated preplots in grid coordinates, converted these coordinates 
to WGS84 geographic coordinates, and then allowed the user to create stakeout files for the Trimble system. QuikView 

converted the stakeout files back to grid coordinates. Both programs allowed these functions to be conducted graphically. 

 
GPSeismic now includes support for numerous GPS, inertial and conventional systems and contains an application called 

GPSQL for data management. An MDB database serves as the repository of all surveyed points and associated quality 
control indicators. It may also contain the preplots (aka, stakeout design points).  

 

mailto:clif@gpseismic.com
mailto:rudy@gpseismic.com
http://www.gpseismic.com/
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There are several additional programs that the user can take advantage of. There is a presentation mapping application, 

one that is an incredibly powerful application capable of preplot redesign and coordinate problem solving, one capable of 

conventional data processing, one capable of real time vehicle tracking, and one capable of real time fleet tracking.  
 

In the typical day to day usage scenario, three applications are used. We have preplots that we either generate or import 
into QuikLoad for the purpose of creating stakeout files. QuikView processes these stakeout files and deposits all 

survey data into a Microsoft database. GPSQL allows you to access this data and create any conceivable client 

deliverable (coordinate files, reports, graphs, etc.). 
 

 
 

There are two other applications you might find yourself using quite frequently: 
 

QuikMap 

 
There is often the need to modify preplots in some manner. Perhaps there 

are exclusion zones that require that points be deleted or moved. QuikMap 
is a powerful application that allows the user to make these modifications 

and much more. So it might very well be that for a particular project, 

QuikMap is first used to make the required preplot modifications, and 
these modified preplots are then imported into QuikLoad.  

 
Note that QuikMap can do a lot more than just preplot re-design. If you 

need to work with DEM‟s, exclusion zones or image processing, this 
program is for you. 

 

 
 

QuikCon 
 

In some areas around the world, conventional surveying 

still rules. GPSeismic® contains a conventional data 
processing program called QuikCon which outputs 

coordinate files or a special proprietary file suitable for 
import into QuikView. It specializes in processing 

reciprocal type traverses and currently supports over 
twenty formats including TDS , Western/Geco‟s DCO, SP3, 

CGG‟s CHE and JOB, Sokkia, Swift, SDR 20 and 33 and 

GSI.  
 

The rest of the story … 
 

The remaining programs might or might not be utilized depending on the user's needs. They include a mapping 

application called GPArc which is based on ESRI‟s ArcObject libraries, an application called GPNav which is used for 
vehicle tracking and vessel navigation, one called GPLocator capable of monitoring up to 100 vehicles in real time, 

QuikEdit, a Windows editor, and NGSearch, a program which searches NGS control data CDs. 
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Software Installation 
 

You will install from the file you downloaded from our website at: 
 

http://www.gpseismic.com/.  
 

Perform a full installation. Note that manuals are in RTF format and are automatically installed in the Manuals folder. You 

can check for recent manual updates on our website.  
 

The installation is your typical run-of-the-mill installation with one exception. If you are installing for the first time 
on a computer DO NOT plug in the security key until after you install the software (and drivers) and have re-

booted. If you do, Windows might get confused as to what USB driver should be installed and install the wrong 

one. Also, note carefully the last dialog that gives you the option of installing the security key software drivers. You do 
want to do this if you have not done it on a previous version install. 

 
 

Other required files/programs you might need -  
 

Geoid model - We support every model in use today that we are aware of, both continental and global, however, we are 

not authorized to distribute models. Some can be obtained via the web. For example, Geoid 99 0r 03 can be obtained 
from: 

 
http://www.ngs.noaa.gov/GEOID/ 

 

GPSeismic® expects the geoid model files to be in their native format as distributed by the respective government or 
university agencies. Note that Trimble users should not use the Trimble supplied .ggf files with GPSeismic because they 

are modified models for use with Trimble products only. They do not produce valid values with any other applications. 
The same might hold true for models obtained from other commercial entities. 

  

Data collector serial communications software – For Trimble equipment, Trimble‟s  Data Transfer is required 
regardless of whether PCMCIA cards or serial comms is used. The reason is that Data Transfer converts the ASCII upload 

file to a proprietary binary 'JOB' file that the collector understands. Leica users need Leica Workbench only if they intend 
on using serial communication for controller upload/download. The preferred Leica method is use of ATA Flash Ram 

(System 500/1200) with a PCs internal PCMCIA slots.  Proprietary communication programs must come from the 
respective vendor. 

 

Interpolative datum transformations models  - The file associated with the NADCON NAD27<->NAD83 datum 
transformation (conus.ncn) is supplied with GPSeismic. So is the Canadian NTV2 file. There are many other similar files 

distributed which can be found in a folder called „\GPSeismic\Geodesy\‟  once GPSeismic is installed. This includes state 
Harn files.  

http://www.gpseismic.com/
http://www.ngs.noaa.gov/GEOID/
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Known Software Issues 

 

To be sure, there is always the possibility of installation issues. In some cases, however, these „issues‟ have been seen 
before and there are well known answers. Here is the top software installation issue as of this writing: 

 
Security key not being recognized – For GPSeismic® to run, either a hardware security key or keyless license is required.  

 

Keyless licenses - The keyless license is a file we can e-mail the user. After being installed, it serves the same purpose as 
a hardware key. Since this type of key can be time limited, it‟s useful for demos or individuals who want to rent the 

software. To make this file, we require unique computer ID numbers. This is done by running the llave.exe program in 
the GPSeismic folder and selecting the Keyless menu item, „Determine Computer ID‟. You e-mail us these numbers. The 

file we make contains these ID numbers and the time frame for which it is to allow applications to run. What if it doesn‟t 
work? The reason is usually because of a time issue. For example, because you might be in another time zone, the 

license might not „kick in‟ for a couple of hours 

 
USB key – If you have purchased a USB key, when you received it, it was programmed to run the latest software as a 

time limited demo. Once the key is safely in your hands it is necessary that you use the „Black Key‟ menu in the llave.exe 
program located in the GPSeismic folder to retrieve a „request string‟ from the key which you e-mail us. We respond with 

an „update string‟ which when sent to the key, again using the llave.exe program, will program it to run the applications 

permanently. Note that the key is not limited to one computer. If you want to run GPSeismic on another 
Computer, install the software on that system and plug the key in. 

 
If a USB key doesn‟t work, there are a few possibilities and include the obvious, „Is it inserted securely in the USB port?‟ 

and „Is it programmed to run the installed version?‟. The not so obvious reasons include, „Is the security driver is 
running?‟ and „Is the USB port working properly?‟. 

 

To see if the driver is running, you might want to run one of your system accessories called MSInfo. Under „signed 
drivers‟ look for something like SafeNet Sentinel Hardware Key. This is the driver that allows the key to function. If you 

don‟t see this, remove the security key, then run the „Security Key Driver Installation‟ utility. You will find this if you press 
„Start/GPSeismic/Security‟. Restart your system, plug the key in, and then see if the problem is cured. 

Note that when you insert the USB key before installing the security drivers, Windows attempts to install what it believes 
is the appropriate software for the device. Then, when you do load the drivers, they are not installed since Windows is 

'happy' with what it has. Suppose you did insert the key before installing the security driver. You might want to go to 
Control Panel/System and run Device Manager and look for USB controllers. You will probably see a reference to 'USB 

Root Hub'. Select this and uninstall. Next, reboot and then install the driver as above and then insert the key.  Windows 

should find the device this time. 
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Using GPSeismic® 
 
First Things First – What is the WGS84 datum and why does it come into play? 
 

To make it as simple as possible, there are many latitude/longitude systems, not just one. For example, one survey 

marker can have several sets of latitude/longitude coordinates, each a bit different from the other. In the United States, 
survey markers have latitude/longitude coordinates that have their origins in a large conventional survey effort carried out 

in the early 1900‟s. However, with the advent of GPS, survey markers also have a second set of latitude/longitude 
coordinates that have their origins in satellite observations of that marker. The first set of latitude/longitudes is called 

NAD27 which is short for North American Datum of 1927. The GPS-based latitude/longitude system is called the WGS84 
datum which stands for World Geodetic System of 1984.  

 

The sweet short summary of these different systems is this. Each latitude/longitude system along with a mathematically 
defined shape on which the coordinates exist is called a datum. The shape is called an ellipsoid and NAD27 uses one 

called „Clarke 1866‟ while WGS84 uses one called, not surprisingly, „WGS84‟. WGS84 is a world datum and is available 
anywhere. Regional datums such as NAD27 are only used in a specific area. Our primary problem is that the difference 

between identical coordinates in WGS84 and a local datum can range from very small to very large (hundred of meters), 

and although we must normally report final survey coordinates in the local datum, we should perform GPS surveys in the 
WGS84 datum. 

 
Go to any of our seminars or read any book on precise GPS surveying, and you will see this recurring theme that when 

using GPS, WGS84 coordinates and ellipsoidal heights should be used at any real-time reference and that errors can 

result in the rover positioning if there is a difference between the actual WGS84 coordinates of the reference and those 
that are utilized (i. e., local). Why is this? 

 
As an analogy, consider the use of a total station in placing several points at predetermined 

locations. We are given a setup point and a computed range and bearing for each point. A last 
minute change requires shifting all points 5 meters south so a decision is made to add 5 meters to 

the computed ranges. This would prove a correct solution only for the points due South of the total 

station and increasing error would result as the bearing deviated from this.  In summary, altering the 
range only is incorrect and we must alter ranges and angles to establish a new framework in which 

we can work. 

 

Now, substitute a GPS satellite for the total station.  Whenever we alter the true WGS84 coordinates 
of a GPS reference station, we artificially alter the computed satellite ranges. This means we alter the 

range corrections that are transmitted since they are the difference between these computed ranges 
and those we observe. We thereby make the same mistake that was made in the analogy.  In this 

case, real-time surveying results will only be correct at the reference station and degrade in accuracy 

as we move away from it. In summary, altering the computed range is incorrect, and since we can 
neither change the location of the satellite or its navigation message, we must use the framework 

within which the system operates. Namely, WGS84.  
 

 
There‟s an additional item to consider. If you use mean sea level height at the 

reference, the rover is not necessarily going to record a mean sea level height 

because frankly, sea level isn‟t level. It‟s a surface that undulates in response to 
gravity. Consider Carlsbad, New Mexico. In this region, the gradient can be 0.5 

meters per 5 kilometers. So if you use msl height at the reference, the recorded 
“msl” height 15 km away is 1.5 meters in error. For this reason, you should use 

WGS84 ellipsoid height and then in processing, use a geoid model to convert 

each point‟s height back to msl height. A geoid model is a sort of magic black box that, given WGS84 coordinates, 
provides a value that can be used to convert a WGS84 ellipsoid height to local height. 
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So before we dive into the software, 

let‟s look one final time at the roles 
GPSeismic® applications have in 

assisting you in making these 
conversions. 

 

As can be seen above, QuikLoad converts the grid coordinate preplots to WGS84 stakeout coordinates, QuikView converts 
the recorded WGS84 geographic coordinates back to local datum grid coordinates using the same datum transformation 

method as QuikLoad (but in reverse), and importantly, QuikView separately converts the recorded WGS84 ellipsoid 
heights to orthometric heights, and does so on a point by point basis through the use of a geoid model. Finally, GPSQL 

serves to manage all of this data and provide required files, reports, etc. 
 

At this point, we start with our first GPSeismic application called Project Manager. This application allows you to answer a 

series of dialogs so that QuikLoad, QuikView and GPSQL are all configured with the same geodetic parameters. 
 

 
 

Project Manager 

 
In Project Manager, you may create a project at which time you are asked to select 

a coordinate system, a datum transformation method, and a geoid model, and then 
prompted for several other important processing parameters. Once these selections 

are made, you can operate the various applications and will observe that the 
system selected in Project Manager, the geoid model, and other preferences are 

being utilized. It is possible to avoid Project Manager and work with the 

applications only, choosing systems and entering parameters as you go. However, 
by using Project Manager, you are less likely to forget one or more, and by using 

Project Manager, settings for each project that is created are saved and allows for 
switching between projects later on.  

 

 
Managing Your Geodetic Settings 

 
You must choose a coordinate system and a datum transformation method when creating a project. GPSeismic® ships 

with dozens of predefined coordinate systems and datum transformations. All of the parameters associated systems and 
datum transformations reside in the „Geodsey.mdb‟ file which is located in the „\GPSeismic\Geodesy\‟ folder. You can 

access the database by selecting „Geodetic Settings‟ from the utility menu of Project Manager. The same geodetic settings 

utility can be accessed from all of the GPSeismic applications. Before we create our project, lets delve into the geodetic 
settings utility and see how we can view the parameters of a coordinate system or a datum transformation. 

 
When the main geodetic settings interface is displayed, you have 

the choice of about a dozen items.  This includes a conversion 

calculator, geoid heights calculator, and a number of viewing and 
creation utilities. 
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If we choose „View Coordinate Systems, we 

will see that there are „Groups‟ that define a 

particular set of systems (e, g., State Plane 
systems) and then the actual coordinate 

systems in the group. A coordinate system is 
defined by its projection type (TM, Lambert, 

etc.) which in turn dictates the parameters 

which define it. It‟s beyond the scope of this 
document to delve much further into 

coordinate systems. Suffice it to say, your 
coordinate system is probably included and 

when it comes to selecting your local 
coordinate system during project creation, 

you will be selecting two items, namely, 

„Group‟ and „System‟.  
 

 
 

 

 
 

 
 

 
Regarding datum shifts, there are many 

defined shifts. Some use interpolative „black 

box‟ methods such as the one listed as 
„NAD27‟. This datum transformation uses the 

shift file, „conus.ncn‟ which we distribute with 
the installation. Most everyone in the US uses 

this. In Canada, most everyone uses an 

interpolative datum called  „NAD27-CANADA-
NTV2‟ which uses the NTV20.gsb file (also 

distributed with the installation). If you intend 
on using either of these datums, take note of 

the name given and skip ahead to the topic,  
Creating The Project…at last now. 
 

Other datum transformation use shift values 
(3, 7 or 10) which can be viewed. The three 

parameter type, called Molodensky, are often 
mean or average shifts for a region or country 

and are not normally used as the primary 

Local<->WGS84 transformation. So instead of 
starting Project Manager and immediately 

creating a project, we might  first create a 
datum transformation we can select during 

project creation.  We will do this below and we 

will need the coordinates in both the local and 
WGS84 datum for the same point. 
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Creating A Datum When Geographic Coordinates For WGS84 And 

The Local Datum are Known 
 

 

Step 1 – Select „Create Datum Transformation from the Geodetic 
Utilities dialog. Enter a name and description for the datum 

transformation. The name (and all others) will appear when you 
create a project and you must select it so make sure it is 

distinctive and can be easily spotted. Also (and very 
importantly), select the ellipsoid to be associated with this 

datum. For example, if you were working in North America, this 

would be Clarke 1866. 
 

 
 

 

 

 Step 2 - On the dialog above press the tool button, „Create (At A Point)‟. For 

seismic operations, the suggested datum transformation method is a three-
parameter shift (aka, a Molodensky shift) in order to preserve the relative 

positions of the seismic stakeout locations. If these parameters are not known 
explicitly, they are determined using this utility.    

 
In the Create-Datum-At-A-Point dialog, to derive a three-parameter shift, you 

must choose the ellipsoid associated with the local datum, and enter the 

geographic coordinates in local and WGS84 datums for a single point, then press 
the Compute button. You should then see the geocentric offsets in the bottom of 

the dialog. Note here that the entry format for geographic coordinates is quite 
flexible and includes DD MM SS.sss, DD.ddd, and unsigned assuming the 

hemisphere is designated (e.g., the local west longitude entered could be entered 

–92 45 31.0300 or 92 45 31.0300 W). The 3 parameters values represent the dx, 
dy and dz shifts to WGS84 respectively. If you leave the checkbox on this dialog 

checked, then the three parameters will be copied to the „Shifts To WGS84‟ X,Y 
and Z textboxes of the parent dialog. The final step is to press „Update‟ on the 

parent dialog. That datum transformation should now be available for selection at 
a later time. 

 

Creating a Datum Transformation When The Specific Parameters are Known 
 

Creating a datum transformation when you already know the datum transformation parameters requires you to display 
the dialog as in Step 1 above, selecting the method and ellipsoid, and then simply entering the parameters. The datum 

transformation is normally one of four types: 1) a three-parameter shift, 2) a seven-parameter shift, 3) a ten parameter 

shift or 4) an interpolative “black box” type such as NADCON or Canada‟s NTV2. In the case of the latter, the shift file 
must exist in the „\GPSeismic\Geodesy\‟  folder and you must select it on the dialog. The final step is to press the „Update‟ 

button with the „add‟ option chosen. 
 

TIP - The most common mistakes made when creating a datum is to fail to select the proper local datum ellipsoid or to 
enter signs incorrectly.  

 

NTV2 Note – For you Canadians, we have a Datum listed in our geodetic 
database for the NTV2 interpolative datum transformation.. 
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– If you are a good surveyor, once either a datum transformation or coordinate system (or both) have been 

selected or defined, you should test the conversion against known coordinates using the conversion calculator 

available from the main Geodetic Settings dialog. In fact, it wouldn't be a bad idea to compare what the GPSeismic® 
conversion calculator gives you against another conversion program. 

 
Creating the Project...at last 

 

IT’S GO TIME! The first dialog to be displayed prompts the user for the most 
important information in the entire project creation sequence, namely the coordinate 

system and datum transformation method. If you don't know what this is for, bail out 
now and start reading from the top of this document again. Make sure for the 

following exercises, you select the settings you see here. 
 

Note that on the dialog the „Select‟ button displays, you can press the buttons next to 

system and datum to list the specific parameters for that item. If you were using 
NAD27, you would expect to see that you were using the conus.ncn shift file if you 

pressed the button next to the datum. 
 

On the same dialog, the user can select the geoid model to use. If one is not 

available at this point, the user may ignore this selection and move forward in creating the project. However, if one is 
available, the user can navigate to it and select it. The possible models are available from the file dialog file filter. If you 

skipped this step, make a note to yourself to get the geoid model and specify it in the Preferences menu of QuikView and 
GPSQL, or alternatively, you can modify the geodetic parameters of the current project (which will eventually be the one 

we are creating). 
 

Note – It is unlikely you will adjust heights based on a selection of a classical datum shift (3 or 7 parameter), but if you 

do, check the appropriate box and skip the selection of the geoid model.  
 

 
The next dialog allows the user to add specialty fields to the database and/or 

change the names of several fields in the database rather than use their default 

names. If changing the names of default fields, the data placed in these fields 
does not change! Only the field names are affected.  

 
If you choose the last item of the drop list, you can select a database model. The 

new project database will contain all the fields the selected database contains.  
 

Note that if you fail to add a specialty field at this point, it‟s always possible to 

add fields to the database later in the application, GPSQL. 
 

 

 

 The next dialog to be displayed requires a name for the project, a place to put the project, and a 

subdirectory structure. The name can be practically anything but cannot be the name of an existing 
project. The user can dictate where the project directory structure is placed, but let‟s use the 

default. This action will create a directory structure based on separate directories for receiver and 
sources and create some files in a directory called DATABASE. Don't delete these files or this 

directory. Feel free to do anything you want with the others that are created. They will be empty. 
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The final dialog requires that the user enter several important processing 

parameters. These are not all of the processing parameters, but those that are 
considered to be the most important based on the fact that they affect the 

results that are ultimately deposited in the database.  
 

 Source and Receiver Azimuths - Some of the more important parameters 

are the azimuths that are specified for source and receiver. These are 
required in order to accurately compute Inline and Crossline offsets in the 

QuikView application. These azimuths may be entered in Grid or Geodetic. If 
the user enters grid, a small dialog will be displayed in which the user must 

enter approximate local grid coordinates for the prospect. From this dialog, 
once the user presses Compute, the grid convergence value will appear for the entered point. Press Apply and the values 

will be applied to each of the entered azimuths. The 'Geodetic' option button will then be automatically selected. Now 

select the other items that tell the QuikView application how to discriminate between source and receiver. This is as 
important as entering the correct azimuths! Use 0 degrees for source and 90 for receiver in this tutorial. When the 

approximate coordinate dialog appears, enter an X of 530000 and a Y of 2000000. 
 

There are several remaining items on this dialog that should be addressed: 

 
Bin Digits - the number of digits in the bin (station) portion of the points that will be in the project. Get this wrong 

and the fields which represent the line portion and station portion of a point (what we call Track and Bin), will be 
populated incorrectly. Use 4 for this tutorial. 

 
Local Time Offset - offset from GMT. Again, there are two time fields in the database, local and GMT. Leave this at 0 or 

get it wrong, and your local time will be wrong. Not devastating but you might as well address it here. 

 
Checkpoints - When QuikView adjusts heights by applying the geoid/ellipsoid separation for a point, any points with this 

user entered character string will not have its delta-height from the preplot recalculated. Therefore, the measured 
differences between monument height and recorded height in the field will be preserved.  Checkpoints are also used in 

other places in QuikView for quality control. Have two strings which represent checkpoints? Enter both and separate by a 

comma. We won‟t concern ourselves with this for our tutorial so you can use the default. 
 

QC Parameters - Based on user entries, several quality control checks will be automatically created that can be used in 
QuikView to quickly QC your data when processing data. These queries, for example, may reflect the user‟s desire to 

isolate GPS code tracking points with undesirable DOP or number of satellites, large offsets, or bad instrument heights. 
Alternatively, the user may build his own queries using the Build tool button. This launches the Query Building dialog that 

allows the user to save named queries that will help in the QC process. Remember that it is always possible to build these 

queries from QuikView at a later time. 
 

When the project is finally created, it will appear in Project Managers project list. The user is prompted for whether to 
make the settings current. Note that if the user chooses NO the settings can be made current at any time. If this is the 

first project, you obviously make them current. 

 
Before exiting Project Manager, look at all current settings in the right of the display. Glance through these. These are the 

current settings for your project. 
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Note that when you created the project, if you used the default structure, you created several 

directories, all of which are empty except „database‟ which contains an empty database 
(.mdb), Geodetic Parameters file (.gdp), miscellaneous settings file (.set), a history of 

everything you do for this project (.log), and a file of stranded preplot points (.uhf).  
 

Final thoughts on Project Manager - You should create another project in Project Manager. 

Once you do, try switching between the two. You do this by clicking the one you want to be 
current in the list. Choose the menu item, „ Restore This Project To Current‟. You will be asked 

if you want to backup current settings. It‟s a good idea to answer Yes to this in almost every situation. Doing so will take 
every parameter from every application and place them in the project‟s SET file. After you restore the project, you can 

make any change you want and when you restore the original project, you will be back to the state at which you left it. 
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QuikLoad – A Brief Tutorial 

 

Before following along with this tutorial, make sure you have created a project as described above and that you used the 
NAD27-Mexico datum transformation and UTM/15N as the Coordinate system. Once you have done this, start QuikLoad. 

 
There are no preferences you really need to address. The database and log file paths were automatically created when 

the project was created as well as selection of the coordinate system and datum transformation. The status bar at the 

bottom displays these items. In fact, for a detailed look at datum shift and coordinate system, double click the respective 
panel. Note that for an actual job, two items you might want to check are selected GPS system (on the Miscellaneous 

dialog) and path to the serial communications program (in the Preferences menu).   
 

For this tutorial, lets select Trimble. Now let‟s import the GPSeismic_all_preplots.sp1 file from the 
/GPSeismic/Preplots/ directory of Sample Data. Select Open Input File from the File menu and then navigate to and 

choose the file. You will see the ASCII Specifications import dialog. 

 
ASCII Specifications import dialog - Spend a lot of time with this dialog 

making sure you properly import the file. There are file preview options 
which allow you to see if you are importing properly. Note that any changes you 

make while a pre-defined format is selected will change the defaults for that 

format. However, press the Restore Standards button and all predefined formats 
will return to their default state. For this sample file, simply select SEG P1 Grid 

Implied 
 

After you OK this dialog, skip the options to create output coordinate and dxf files, 
but note that any time you want, you can use QuikLoad as a utility to import a file, 

modify it in some way, and save it as a new coordinate file. 

 

Select Coordinate System dialog - When this appears, you will see the project 

coordinate system and datum transformation is selected.  
 

 
After saying OK to the dialog above, you are asked to save a QLD file. This file 

contains the transformed geographic coordinates and original local grid coordinates 

(when WGS84 geographics are imported, the QLD file contains the same 
information, but the geographics are the original input coordinates and the local grid 

coordinates were transformed). This is an important file. You don't have to transform grid coordinates every time you 
want to upload. You only do that the first time and then you can simply import the QLD file in subsequent upload 

sessions. 

 
The next dialog is a file dialog allowing you to name and save the upload file. If, as instructed 

above, you have Trimble selected as the supported GPS receiver, you will be instructed to 
save a “.DC” file and the next dialog is as shown at left. On this dialog, you specify the data 

collector firmware version and job name. The geoid height allows the Trimble data collector to 
display (but not record) approximate msl heights. If you specified a geoid model when the 

project was created, you can press „Compute‟ and a value most suitable for the current 

coordinates is entered. The unit option will „wake up‟ the collector in this mode. 
 

Note For Leica users  - If you are a Leica user, see the appendix which shows you important 
differences in the upload process.  
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Verifying coordinate transformation - Once a file is imported and transformed, you can verify 

coordinate transformation by right clicking on a point. The WGS84 coordinates and local grid 
coordinates are displayed. The coordinates should be “reasonable” and for control points, 

there should be a match with published coordinates for this point. By the way, right click with the 
Shift key pressed and you will get a modal dialog. Press “Esc” or click on this dialog to get rid of it. 

 

If the coordinates were imported and transformed correctly, let‟s append preplots to the database at this point. We only 
have to do this once (as opposed to QuikView in which case we will be appending the surveyed data each day). You 

append the database by selecting File/Database and pressing the „Add all...‟ button on this dialog. 
  

At this point, you normally select and populate the controller file. One of the easiest ways to do this is to “lasso” the 
points. You lasso by double clicking, than single click at points defining the polygon, and then double click at the point 

where you started. You will see a dialog that asks whether to place all points in the collector file or „Refine Using SQL‟. 

You can send all points to the collector file, or you can send a subset by defining a “query”. If you press Yes, all points 
are used to populate the collector file. Select „Refine Using SQL‟. 

 
Refining the contents of a lasso - If you say No, then you will see a spreadsheet of 

all selected points. If you press the “build query” tool button (a hammer), you will 

see the query building dialog. It‟s beyond the scope of this tutorial to discuss all 
facets of query building, but if you wanted just sources, you would go to the 

second tab page, select Station (value), the „>‟ symbol for operator, and type in 
any number greater than the highest receiver number (try 50000000 here). Then 

press “And into criteria”. Press the far left tool button on this dialog and the 
spreadsheet content will reflect the query, and finally press the QuikLoad tool 

button (looks like a multi color collector), an action which sends the selected 

points to the collector file. On the map display, the points in the collector will 
become green, the points not in the collector, red. 

 
Remember that for making any other upload files on subsequent days, it is only 

necessary to import the QLD file and select the points desired for the upload file. 

It is not necessary to transform the coordinates each time. How you actually get 
the upload file into a particular manufacturer's collector varies. “It is beyond the 

scope of this presentation…” is a polite way of saying, get the manufacturer‟s manual out now. Some systems use serial 
comms, but most use cards which can be inserted into the PC and appears as additional hard drives. So uploading is as 

easy as moving a file using Windows Explorer. 
 

A word about UHF (Upload History) files. -  The default behavior of QuikLoad is to create a file of station names for all 

points uploaded. When you import your QLD file the next day, this file is utilized to both color the previously selected 
stations green (i.e., those in the UHF file) and make them un-selectable for upload. You can change any of this behavior 

in the Miscellaneous dialog, and a cool thing to do is take advantage of the database and have QuikLoad automatically 
replace this file with all points that have been surveyed. See the UHF tab page of the Miscellaneous dialog for this option. 

What you want to do is create a query which isolates all valid Postplot table survey points. Then, QuikLoad will recreate 

the UHF file each time it is started. It means you will essentially be working with a map of points in which you can 
discriminate between surveyed and non-surveyed points. Confusing? Yes, at this point of your learning, it is. However, it‟s 

quite useful so if you want to blow this off right now, do so. Just make a note to yourself to visit this feature at a later 
time. 
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QuikView – A Brief Tutorial 

 
QuikView processes data collector files that contain survey data. The data collector files have either embedded preplots 

that allow computation of offset values, or they don‟t in which case QuikView can reference a QLD file from which the 
offset values can be computed.  

 

Note that as with QuikLoad the database and log file paths were automatically created when the project was created. The 
same for coordinate system and datum transformation. The status bar at the bottom displays these items. Just like 

QuikLoad, two items you might want to check are selected GPS system (Trimble, Leica, etc.) and path to the 
communications program if using serial communications. For GPS system, select Miscellaneous in the Preferences menu. 

For communications, select Download Program in Preferences. If you did not specify a geoid model when you created the 
project, specify this one in the Preferences menu. 

 

Open the GPSeismic_New_Ver_7.dsc file now. You will do the same thing on an actual job except that you will have 
to download the file first from the data collector using the appropriate means.  Once file is downloaded, you will see a 

series of dialogs starting with a message box confirming the checksum (Trimble only). Again, if you are a Leica user, you 
will have to see the appendix that deals with the files that apply to that system 

 

 
Station dialog - The next dialog allows you to choose what to use for the station name. For this 

sample Trimble file, use the Code Description. Note that Trimble equipment refers to two 
possible 8-character fields. Leica actually has one 16-character station name that can be broken 

down into two 8-character fields by GPSeismic®. 
 

 

HI dialog - The next dialog allows you review and possibly change the instrument heights used 

by the rovers. What you will see is every HI used for ranges of stations. You can see each range 
by using the scroll arrows. Entering a new HI and pressing Update can change any of these. The 

effect of changing the HI is to change the ground adjusted height. Note that this dialog can be 
displayed by selecting “HI Entrys” in the File menu at any time during the processing session.  

 

 
If you have processed this file before and had made some changes to the HI and perhaps some 

station name changes, an „edit‟ file would have been created in the same directory as the data 
collector file. A raw file is never altered, so changes are recorded to this EDT file. If one exists, QuikView will ask at this 

point if it should re-apply these edits.  
 

Minimum processing steps - You can do a number of things to QC the data, but minimally, to process the data you have 

to: 
 

perform the horizontal transformation… 
 

  and perform the vertical adjustment.  
 

Note that specific QC methods vary greatly, but some suggested items are: 
 

use the „Changes‟ dialog (or try double clicking a point) – this is used for station name, HIs, and comment changes. 
Try making at least one change here. Notice two things. One is that you must press the „Update‟ button on this dialog for 

the change to take effect. The second is that when you type in any change, an „update all‟ button appears. Check this 
and all points will be changed to your entry. 
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use the „Masks‟ dialog which can isolate bad DOPs, precisions, unit variance. This is the query builder dialog we saw 

briefly in QuikLoad. This is a complex dialog and you still might be uncomfortable with it. That‟s all right. Skip this part for 

now. 
 

Here are some items that are very important, however if you addressed them when creating a project, you shouldn't have 
to address them now. If you want to check, click on the tool buttons below: 

 

… local time offset, number of digits in bin portion of station, and checkpoint designation. All of these are located on 
the Miscellaneous dialog. 

 

… rx/source azimuths; determination of rx and source. You can enter these on the Offsets dialog but again if you 
created the project „correctly‟, you shouldn‟t have to change these. 
 

One final required item is to update the database by pressing  and pressing „Update Database‟. On this dialog you can 
also create any desired reports or chart.  

 
Final thoughts about QuikView - Note that QuikView NEVER alters the input file. All changes are done in memory, and will 

indeed be reflected in the database. Also, a small separate file is created with the edits you make. If you open the same 
file again, you are prompted for whether to re-apply previous edits. Given this, you should play around a bit with the 

sample file and try changes HIs and the like in order to gain some insight into what you can and can‟t do to the data. 

 
Also, take a look at the utility menu and you can see that there are numerous supported data formats and systems. There 

is also a generic ASCII import feature that allows you to import practically any file that might be out there. 
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GPSQL – A Brief Tutorial 

 
What is GPSQL? All processed data whether it is GPS, Conventional or Inertial is placed in an MDB database and GPSQL 

allows you to open the database and create reports, seismic files, map files, and much more. It‟s the core application for 
all of your data management requirements and believe it when we say that when you are dealing with what could 

potentially be tens of thousands of survey locations, data management is key. GPSQL has many built in functions that are 

tailored for the seismic industry. One thing you should know is that it is NOT necessary to have Microsoft Access installed 
on your computer. We install all required data access libraries. 

 
 If we start GPSQL and take a look at the user interface, you will 

see the left side is reserved for up to 99 queries. A query is a set 
of instructions, that when executed, will tell the database what 

records we are interested in. In GPSeismic databases, there are 

normally two „tables‟ called POSTPLOT and PREPLOT. You can 
think of the database as a big box containing all the data. Inside 

this box are two smaller boxes, each containing related 
information. The Preplot table contains all the  points that have 

to be surveyed. The Postplot table contains all the points that 

have been surveyed. A query can be defined which contains only 
selected points from either of these tables. 

 
When you click on one of the queries, the specific statement (or 

syntax) is displayed at the top right of the user interface. The 
other user interface panels display specific database information. 

As with QuikLoad, the database and log file paths were 

automatically created when the project was created and you should see this in the database properties and current 
settings panels. At the bottom is the database structure. 

 
We said that the database contains two tables. Each table contains a number of fields. You can visualize a table a bit like 

a spreadsheet. There would be a point per row, and for each row, there are a number of fields. For example, for each 

point in the Preplot table, there are 14 fields. Here is a brief definition of each: 
 

Station (text) – The name of the point 

Station (value) – The name of the point expressed as a value  

Track – The line portion of the point name 

Bin – The bin (station along the line) portion of the point name 

Descriptor – An optional piece of information about the point 

WGS84 Latitude – The latitude of the point in the WGS84 datum 

WGS84 Longitude – The longitude of the point in the WGS84 datum 

Local Latitude – The latitude of the point in the local datum 

Local Longitude – The longitude of the point in the local datum 

Local Easting – The easting (x) of the point in the local datum 

Local Northing – The northing (y) of the point in the local datum 

WGS84 Height – The height of the point relative to the WGS84 ellipsoid 

Distance Units - linear units („meters, „US Foot‟, etc.) 

Distance Factor – value to convert linear unit to meters 
 

The Postplot table contains the same fields, but also includes some forty additional fields that are associated with the 
surveyed point. These include QC indicators, time shot and offsets from the preplot point. 
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 Preferences - Display the Preferences/Options dialog but for now don‟t change anything. Just remember that there are 
certain options you might want to exercise at a later time and this where you will go. For example, the dialog contains 

options that allow you to create a backup each time you start GPSQL.  
 

 We can build six template queries by pressing the tool button at left in the Define menu 

and then entering a value that separates receivers from sources numerically (30000000 will do) in the dialog that follows. 
You will the be asked at which number (1-99) to place the queries. Leave this at 1. What will appear will be six SQL 

syntax queries that isolate all postplots, source postplots, receiver postplots, and the same for preplots. Select each and 
look at the SQL syntax and chances are you will gain immediate insight into the „language of databases‟. 

 

Note that we could have built our six template queries using the project queries button as 
well. We would have obtained the same queries but the descriptions would have been clearer in the sense that they 

would have referred to „source‟ and „receiver‟. This was made possible by your choices earlier in Project Manager. 
 

Here are some things you can do with the currently selected query: 

 
 Press one of the eye icons in the QueryA menu to display the records in a spreadsheet. There 

are two spreadsheet viewers. The classic has been around for a while and will disappear in a 
future release. The standard viewer has superior display capabilities . The classic on the other 

hand is a bit faster to load and allows the user to edit cells in one step. The modern viewer 

requires edit followed by a save. 
 

 Press this icon to create a custom report. The custom 
report builder will display all fields defined by the query. You drag these from 

the left side to the right (output) side. Play with the various formatting options 
and press the small „eye‟ icon to get a preview of the first 100 records in the 

format you specified. When you get it the way you want it, you can save all 
records to a file. Yes, there are many formatting options, but that gives you the 

flexibility to create anything the client might desire. 
 

 

For practice, get several fields including easting, northing, latitude and longitude 
into the rightmost list box. Highlight the easting and then northing fields and 

press the „flag the currently selected field for…‟  button with the „this precision -
>‟ selection which annotates the field with a „/p2‟. Select the lat/longs and use 

the „DMS.ssss…‟ selection which annotates the field with a „/d2‟. These 

annotations will be used to tell GPSQL to write the fields to a certain precision 
and/or format. 

 
On the „Format‟ tab page, you can determine if the file will be fixed card column 

or delimited. You can also specify variable card columns. Experiment as much 

as you want here and eventually view the report by pressing by pressing eye 
tool button. This action displays the first 100 records so you can see if it what 

you had in mind. Finally, use the „Save‟ or „Save/Append‟ File menu items to actually save a file to disk. Remember, you 
can‟t hurt anything if the format is wrong, you‟ll just create bad reports. You may save this format with a name by 

pressing  and retrieve it when creating a report with another selected query by pressing .  
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 Press this icon to create a seismic coordinate file. When you initiate this routine, you are first 

prompted for the name of the file. Then the field selection dialog will be displayed. 

 
 The field selection dialog comes up often so let‟s discuss it. In the case of 

seismic files (and other outputs), the required fields are well known. For seismic 
files, the fields include point name (aka, station), local coordinates (grid and 

geographic), local height and an optional descriptor. These are exactly what you 

will see as the selected default fields in the field selection dialog. Can you change 
them? Yes. Should you change them? Not normally. But the flexibility is there to 

do so. 
 

What about the other options? Normally, you won‟t need to use them, but you 

could use them if you had to. For example, there is one option that takes any 
points with the same name and produces one record with average coordinates. 

 
 

 
The next dialog will be the coordinate system dialog. Why? The fields from the 

database do not need to be transformed. They are already in the system/datum 

they should be. The reason for this dialog is simply to create an appropriate 
header should you want to. That is an option you get on the final dialog of this 

process. 

 

The final dialog is the standard GPSeismic ASCII export dialog. As with the import dialog, if 
this is a new installation, the first thing you want to do is press the Restore Standards button 

so that several industry standard formats become available for selection. Again, as with the 
import dialog, spend some time here to look over your options.  Use the „Preview‟ Button to 

examine what a record will look like. Also note that you can include a header by checking the 
appropriate box and if necessary, you can type into the header textbox. Any change is 

remembered the next time you display this dialog. Also note that the header created by 

GPSeismic does not adhere to any standard (such as SEG since it itself has a nebulous 
definition). 

 
 

Other Query Actions - To be sure there are other things you can do with a selected query (well over forty). This includes 

immediately mapping the results using QuikMap, making a DXF file, and graphing up to six fields. Displaying and 
reporting are the most important so that‟s why we took a closer look at this. Note that anything you do with a query 

involves displaying or reporting the data, not modifying it. So feel free to look at any or all of these actions if you want. 
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Building Queries 

 

Let‟s first change our direction now and build a query. At this point, select the seventh query that is 
currently undefined. Then press the build query button from the Define menu which displays the query builder dialog. 

 

 

Building queries - When the query builder dialog is displayed, click once on the 
POSTPLOT table and the display will look like that at the left. On this first tab page, 

you can change the way the records are ordered, the default being the first field in 
the table. You can select specific fields for display, but don‟t select any at this point. 

Note that by selecting View in the Query menu you can display the results of your 
query. At this point, it is all POSTPLOT records ordered by Station (text). 

 

Tip – A better field to order by is actually Station (value). The Station (text) field is 
just that, text. The ordering does not normally give you what you expect. 

 
 

 

On the second tab page, this is where the 
user specifies various „criteria‟. These are statements that determine a subset of 

the records. Here we have said to return only the records where the station 
value is greater than 30000000, in other words, the sources. Display this query 

to verify it is what you might want.  

 
Note the „include DISTINCT …” checkbox on this page. It‟s normally not 

selected. When used, it excludes records which are identical to another record. 
If you have exact duplicates as would be the case if you processed the same file 

twice, its best to use a „Modifications‟ tool called „Purge Duplicates‟ to actually 
remove them from the database. 

 

 
 

 
 

Delete the criteria above (highlight the text and press delete) and then select Station (text), „Like‟ for the operator, and 

„*carito*‟ (without the single quotes) as the value. Press the „And Into Criteria‟ and then display the results. The 
significance of the asterisks is that the represent wild cards. Essentially you are saying to return everything that has the 

string „carito‟ in it.  Note that with regards to text, GPSQL is not case sensitive. 
 

In order to copy the query you have built to query 7 that is currently undefined, either press the top left tool button or 
make sure 7 is selected from the dropdown in the toolbar and press the arrow to the left.  

 

On the main display, you will see the actual syntax of the query displayed. In list item number 7 at 
left, type in a name for the query. You can now click on another query and back to this one and see 

that it has been automatically saved. 
 

When a query is selected you can press the   to modify it. Essentially, the query builder is launched 
in a state exactly like it was when the query was first built (although very complex queries might occasionally pose a 

problem). 
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Displaying Queries - Select a query and 

display it using the „standard‟ viewer. You 
will see a spreadsheet as shown here. If you 

click on a column head, the display will be 
sorted by this field if this is selected in 

Preferences. You can also do a descending 

sort or display statistics for the field (if it‟s a 
numeric field).  

 
The native format for many values is high 

precision. Angles are in decimal degree 
format, but the row viewer at the left 

displays angles in selectable formats. Right 

click on the row viewer panel and select the 
formatting options menu item.  

 
You can edit on a cell-by-cell basis or edit 

several rows at one time. To do any editing, 

you must click the display/modify  tool button. This action temporarily modifies the table to include a primary index 

and places the grid in edit mode. Once edits are made, press the   tool button.  

 
Final Thoughts On GPSQL - There is a Backup feature that creates a copy of the database at startup. This is a good 

feature to turn on. Make sure you make a backup on a floppy, zip, CD or other media as often as you can. 
 

There are many more powerful query building and database modification features we have left untouched, but the ones 

described are required and will handle the majority of data management requirements. Recent additions include Query 
Builder helpers which allow the standard query building dialog to be expanded to reveal neat helper functions for dealing 

with strings, values and dates, and „Aliases‟ which allow the user to create a fields based on an expression which could 
involve other fields. Aliases don‟t really exist in the database, but are nonetheless available for display, reports, etc. 
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QuikMap – A Brief Tutorial  

 
QuikMap does many things and it‟s impossible to cover it all. However, it‟s an important problem solving application that 

needs to be covered so here's a simple QuikMap tutorial demonstrating image support, searches and auto offsets: 
 

You will need the following files: 

 
\GPSeismic\Sample Data\Mapping\GPSeismic_pyramids.jgw 

\GPSeismic\Sample Data\Mapping\GPSeismic_pyramids.jpg 
\GPSeismic\Sample Data\Preplots\GPSeismic_batch.xzo 

\GPSeismic\Sample Data\Preplots\GPSeismic_sr_preplots.sp1 
 

Start QuikMap and from the File menu, import the GPSeismic_sr_preplots.sp1 file from 

the preplot directory.....choose SEG Grid implied decimal from the ASCII specifications 
dialog 

 
From the Image menu, use the Load item and select the GPSeismic_pyramids.jpg file 

from the mapping directory 

 
Go to the Search menu and select 'Begin Batch Search' and then select the 

GPSeismic_batch.xzo  file. In a second or two, you will see that exclusion areas 
described by the points in the file have changed the status of the points inside them. 

 
In order to auto offset points to places outside the exclusion zones, we must set the 

parameters we want to use. Lets go to the Miscellaneous dialog by pressing . Then go to 
the Auto Offsets page. Enter the values you see here.  

 
Briefly, the spacing values are jumps for QuikMap to take in determining possible locations 

to offset the points. The tolerance is a „nudge‟ to give each point if, after making a spacing 

jump, the point is still inside the exclusion zone. It could be that the nudge (which is 
attempted in 4 cardinal directions) just manages to get the point outside, in which case 

another large jump is not required. The minimum separation is a value that QuikMap will 
use to guarantee minimum separation between any points. The maximum offset limits the 

distance a point will be moved from its original location. 

 
You might wonder what the reference azimuth is for performing inline and crossline offsets. It happens to be the azimuth 

in the status panel on the bottom of the QuikMap display. Since our source points are oriented North/south exactly, the 0 
degrees in the display is correct for this exercise. 

 
Now zoom in on the Sphinx. The exclusion zone will appear as shown here.Now, draw a polygon around the 

exclusion zone by first double clicking with the mouse, then single click, an action that draws the sides of 

the encompassing polygon for each mouse click. It‟s all right to include some green points because when we 
finally perform the auto-offset function, only points inside the exclusion zone will be moved. 

 
When you get very close to the place to where you started, right click to display a popup menu with a number of things 

you can do with the points inside the polygon you have described. 

 
Among the various choices you have in performing an action on the points in the polygon, Auto 

Offset is the one we will select. At this point, there are two ways to initiate the action. One is to 
double click at about the same point where you started the lasso polygon. The second way is to 

right click again to display the popup with that selection made and select „Close polygon and 

process data‟. 
  



GPSeismic® Overview and Tutorial Pg 22 of 28 
 
 

 

The image has been removed here to show clearly the effects of the auto-offset function with the 

parameters we used. Although we didn‟t do it here, we can limit the offsetting to inline or crossline, or 

constrain it to a swath through the use of grid definition files.  
 

 
As with any operation, you can select the File menu item, Outputs in order to display 

the Outputs dialog. From here we can send primary, hit or any other category of points 

to a coordinate file, DXF file, or SHP file. We could also save the current search zones 
as a SHP file or DXF file. 

 
 

A few final thoughts on exclusion zones –  
 

We imported an existing exclusion zone (.xzo), but how would we make such a file? There are two ways: 1) We can 

import ASCII coordinate files which represent features such as wells, and in this point mode we would specify a radius to 
use. We can also import a file of points that represent points along a line and specify a minimum distance from the line. 

We can also import a file of points that represent a polygon. Each of these searches is initiated by selecting the „Begin 
Search‟ item from the Search menu. 2) We can dynamically draw these types of features. This is initiated by selecting the 

„Dynamic Search‟ item from the search menu. All exclusion zones, no matter what their origin was, can be saved to an 

„xzo‟ file. 
 

Also note that exclusion zones can be made with a specific color and hatching as well as a string attribute. Try double-
right-clicking in an exclusion zone and you will display a dialog allowing you to set these features. 

 
Comparing files - Here's a simple QuikMap tutorial demonstrating comparisons: 

 

You will need the following files: 
 

\GPSeismic\Sample Data\Preplots\GPSeismic_postplot.sp1 
\GPSeismic\Sample Data\Preplots\GPSeismic_sr_preplots.sp1 

 

First, choose Edit/Clear All if you have done anything previously in the application. From the File menu, open the 
GPSeismic_sr_preplots.sp1 as the initial file. Choose SEG P1 grid for import type. 

 
Second, open GPSeismic_postplot.sp1 as the secondary file. 

 
Third, go to the File menu and select the Compare/Offsets menu item. Zoom in to a region where there 

are a significant number of offsets. Preplot points for which a match has been found are red and for 

points with no match, green. Blue points here represent the postplot points in the secondary layer. Arcs 
connect preplots to postplots and can be changed to straight lines in the Miscellaneous dialog. 

 
From the File menu, display the Outputs dialog by selecting the Output item. This time, notice that in addition to saving 

points in several ways, the connecting arcs can be saved as SHP or DXF files. Also, the Reports tool button is enabled. 

Press this then select Yes when prompted about displaying matches only. In a few seconds, a spreadsheet will be 
displayed with the results of the comparison. The spreadsheet will display offsets expressed in several different ways. 

From here you can save a custom report if required. 
 

Note that as with our previous exercise, inline and crossline azimuths imply a reference azimuth. For comparisons, this 

happens to be the azimuth displayed in the status panel. Since our sources are oriented at grid north, the default value of 
0 was correct. 
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Interpolation - Here's a simple QuikMap tutorial demonstrating the interpolation utility: 

 

You will need the following file: 
 

\GPSeismic\Sample Data\Preplots_other\GPSeismic_interpolate.sp1 
 

 

First, choose Edit/Clear All if you have done anything previously in the application. From the File menu, open the 
GPSeismic_interpolate.sp1 as the initial file. Choose SEG P1 grid for import type. 

 
  – In order to interpolate horizontal coordinates and height, make sure to check „Include Height‟ on the ASCII 

Import dialog. 
 

Now go to the File menu and select „Sort‟. This is required to interpolate by what we refer to as the station/increment 

mode. 
 

 
Next, on the map, right click on the West most point while holding down the HOME key. Then 

right click on the East most point while pressing the END key. The grid inverse dialog will be 

shown on which there is an “Interpolate” button. Once pressed, the dialog expands. Press GO for 
the station/increment mode (advanced) and the selected points will appear in the interpolation 

module. 
 

Note – Choosing „basic‟ mode simply interpolates based on the entered increment. It‟s a quick an 
efficient way to interpolate if you do not need to do a more sophisticated interpolation like 

excluding selected points. 

 
The interpolation module shows a map and height profile. We are going to interpolate all missing 

points based on station number. For this exercise, we will enter 1 for station increment in the 
appropriate text box in the toolbar  

 

Press the  button to interpolate the missing points. The Interpolated points are displayed in blue. Try zooming in on 
either graph to view the results of the interpolation. 
 

Finally, press  to remove this dialog and place the interpolated points in the secondary layer. You can repeat this 

process as many times as desired. Ultimately, you can elect to output these points, or append them to the initial layer and 
output the entire initial layer. 

 
Note that there are more interpolation modes and options, but by far, station/increment mode is the most common. Also 

note that the interpolation mechanism is available in GPSQL as well.  
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Moving points - Here's a simple QuikMap tutorial demonstrating the use of grid definition files in moving points: 

 

You will need the following files: 
 

\GPSeismic\Sample Data\Preplots\GPSeismic_sr_preplots.sp1 
\GPSeismic\Sample Data\Preplots\GPSeismic_sr_grd_definition.grd 

 

First, choose Edit/Clear All if you have done anything previously in the application. From the File menu, open the 
GPSeismic_sr_preplots.sp1 as the initial file. Choose SEG P1 grid for import type.  

 
Next, use the File menu item, „Open Grid Definition File‟ to select and open the 

GPSeismic_sr_grd_definition.grd file. A dialog will be shown that displays the parameters of the grid 
definition file. These are all fine for this exercise, so press OK. Zoom in a bit and you will be able to see the 

depiction of the bins with respect to the points. 

 
Carefully, draw a polygon around some points by first double clicking with the mouse, then single click, an 

action that draws the sides of the encompassing polygon for each mouse click. When you get very close 
to the place to where you started, right click to display a popup menu with a number of things you can do 

with the points inside the polygon you have described. Among the various choices you have in performing 

an action on the points in the polygon, Group Traverse is the one we will select. Then we will right click 
again to display the popup with that selection made and select „Close polygon and process data‟. 

 
 

Now, a dialog will be displayed that allows you to move the enclosed points based on 
several offsetting strategies. Let‟s choose „Delta Inline/Crossline‟ and enter 120 for 

the Crossline value. We will also check on „Compute station number‟ and „Create at 

bin center‟. 
 

By making these last two choices, we will ensure that the points are moved exactly to 
the bin center in which it falls (even if we were a bit off in our entered offset value) 

and that the station will be renumbered according to the bin it falls in.  

 
Note that as with our previous exercise, Delta inline and crossline imply a reference 

azimuth. For group traverses, this happens to be the azimuth displayed in the status 
panel. Since our sources are oriented at grid north, the default value of 0 was 

correct. 
 

When we press OK to the above dialog, the points will be moved to their new bin 

locations. 
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QuikCon – A Brief Tutorial  

 

Here is a simple tutorial for use of the QuikCon application. You will need the following sample files: 
 

\GPSeismic\Sample Data\Rawdata\Conventional\GPSeismic_conventional.dco 
\GPSeismic\Sample Data\Rawdata\Conventional\GPSeismic_control.qcc 

 

Start QuikCon and select „Data Collection Editor‟ from the Survey Tools menu. 
From the Import menu, select „DCO (sorted)‟ and then select the 

GPSeismic_conventional.dco file as the import file. This action displays 
the data in the editor. The dialog will look like the one to the left. Rows will be 

color coded according to point code (PCOD). There are typically five types, 
BS=Back sight, TO=Takeoff, RP=side shot, FS=turn point, and IP 

=Instrument point. 

 
Select „Compute Splits‟ from the File menu and the splits and reciprocal deltas 

will appear at right. Split information falls on the face 1 observation of the 
pair. Reciprocal deltas fall on the face 1 record of the turn point of the 

reciprocal pair. 

 

 
On the left side of the dialog, in the Editing Levels group box, check every box except zenith angle. 

Press OK. Once this is done, press the „eye‟ tool button in the group box. Cells containing information 
that exceed the levels will turn red. Go to the Errors tab page and press the „eye‟ button there. A list 

of all errors will be generated with the row they appear on. Click on one and it will scroll to that row. 

 
 

 
Let us assume that everything is OK. We will next make a QCN 

file. This file contains all observations, all split and reciprocal 

data, and most importantly, the required takeoff information. 
For this file we need the coordinates and height of our takeoff point (2264A5167) 

and either the coordinates of our back sight point (2264A5166), or an explicit 
backsight azimuth from our takeoff. This information comes from one of two places, 

either a QuikCon control station file (extension .QCC), or we enter the information 
manually. For this exercise, let us have the takeoff information come from a control file. Go to the „Takeoff‟ tab page and 

press the small button at top. Next select the GPSeismic_conventional.qcc file. That‟s it! Note that if the takeoff 

information were to be entered manually, this is where you do it. 
 

Note – It‟s not necessary to open the QCC file and display it, but if you want to do that now just to peek at the contents, 
select „Display Control Station Manager‟ for the Utilities menu. From this dialog, open the QCC file we selected a moment 

ago. Don‟t change anything, but do note that the coordinates for our takeoff and initial back sight are here. The 

checkmarks essentially say „use me if you need me‟.  
 

OK, let‟s get back on track. We now want to create a QCN file. Do so by selecting „Create QCN‟ from the File menu. Save 
a file with the name, „Sample.QCN‟. Once you do this, exit the Editor dialog. 
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Select "Open Qcn file' from File menu. Select the QCN file created above. 

A spreadsheet of the processed traverse will appear along with a map 
visualization and a height profile. You will notice in traverse data that 

there are over forty fields, many blank and there is no MSL adjustment, 
no SF applied and 0 split values (even though they appeared in DCO 

editor earlier. These are all processing settings that you can elect to turn 

on from the Settings tab page. For example, on the Settings tab page, 
check the split errors check boxes and then press OK. Process the 

Sample.Qcn file again. This time, you will see the applied splits in traverse 
data. You should experiment with other processing settings. If you turn on 

scale factoring, make sure to select UTM Zone 15N. 
 

 

 
Eventually, on the Settings page, select 'use any found in QCC' in the „Fixed BS Azimuths‟ 

group box. Process the Sample.qcn file again and you will see in the traverse data that 
the backsight azimuth of one of the turnpoints was held fixed. The difference between 

the computed and fixed azimuth is extremely large for demonstration purposes. You 

might want to take a look at the QCC control file again so that you can see why this point 
was held fixed by QuikCon. 

 
Try selecting the File menu item, 'Prorate Azimuths ' . The routine does exactly what the 

File menu item says. Any computed/known azimuth difference is prorated backwards 
through the traverse. In the traverse data, you can see all coordinate and azimuth 

change. You will note that the Fixed Az Delta is zero because by prorating, by the time 

this point is processed, the fixed backsight matches the computed azimuth. 
 

You can go further by actually adjusting the coordinates. This can be done by holding 
points fixed in the Control File or doing that individually from the File menu. Eventually, 

you will want to display the Export tab page, specify the output type and preferences, and 

create a report. 
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Appendix A – Leica Notes 

 

 
 

General 
 

 

 
 

If using Leica, when selecting the GPS system in QuikLoad and QuikView, remember 
that there are several systems and you must choose the appropriate one from the list 

that you can drop down. One of the most frequent technical support calls we get for 
Leica users is that they cannot properly import files. This is often traced to the fact that 

they simply have to select the system they are working with. 

 
 

 
 

File format – Unfortunately, Leica data collector files are not like any other. A data collector file is actually many files with 

cryptic names and extentions like „X01‟, „X02‟, etc. All the files that comprise the data collector file are given the name 
„GeoDb‟ which stands for geodetic database. Within this GeoDb, there might exist one or more jobs. Leica GeoDbs are 

typically moved from data collector to computer using flash ram cards. Once inserted in a computer, a flash card simply 
becomes another drive. GPSeismic programs QuikLoad and QuikView have a „Transfer GeoDB‟ File menu item which 

allows the user to move GeoDb jobs from folder to folder. The same dialog in QuikLoad is used to select the folder where 
the GeoDb is placed and the job created. In QuikView the same dialog is used to navigate to the folder the GeoDb is in 

and select the job to be imported. 

 
 

QuikLoad Uploading 
 

 

 
 

In QuikLoad, immediately after you have imported or created 
a QLD file, the next custom Leica dialog allows you to select 

the directory to create the upload System 1200 database. 
You can typically double click to navigate to the desired 

directory. If you want to create a directory, you can navigate 

to the parent directory, type in a name for the new directory 
in the textbox at the bottom of the dialog, and press New. 

 
 

 

 
 

The next dialog will display what jobs are currently in the directory. 
We could select one or create a new one. Here we are going to create 

a new job called ‟MyJob‟. You might or might not see a final dialog 

which has to do with the creation of a Leica transformation set. This 
is information which allows the WGS84 coordinates in the data 

collector to be viewed in local grid coordinates. 
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QuikView Downloading 

 

 
 

 
One important setting to address before importing files with QuikView is whether those 

files have preplot coordinates in them in addition to the surveyed coordinates. Some 

systems do have these and some don‟t. For the Leica 1200 data, we normally have to 
specify a preplot QLD file. In this manner, we can see both preplot AND postplot points 

and generate offsets between the two. You specify a QLD file on the Processing 
Settings tab page of the Miscellaneous dialog.  

 
 

 

 
 

 
After the preplot file is specified (which only has to be done once), 

select „Open Data Collector file‟ on the File menu. As with QuikLoad, 

you will first be prompted for a directory where the jobs exist. 
Navigate to the desired folder. Then you will see a dialog displaying 

the jobs that are in the folder. Check the desired job and press OK. 
 


